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1. UVOD 

Sve više korisnika se odlučuje za uređaje s Android operacijskim sustavom, kao što su pametni 

mobiteli, tableti, računala pa čak i televizori, radi njegovog jednostavnog korištenja kao i 

sučelja otvorenog koda (eng. „Open source project“). Također se sve više programera okreće 

tom području programiranja radi brojnog tržišta. Mnogim aplikacijama potreban je Internet 

pristup što je dostupan skoro svugdje oko nas u obliku bežične mreže ili GSM/WCDMA, kao i 

aplikaciji za slušanje radio prijenosa TV radio UNIOS ETFOS programa. 

1.1. Zadatak završnog rada: 

Zadatak završnog rada je izrada aplikacije pomoću koje če korisnici mobilnog uređaja s 

Android operacijskog sustava moći slušati radio prijenos TV radio UNIOS ETFOS programa. 

Dizajnirati sučelje za aplikaciju te ga povezati s funkcionalnim dijelovima aplikacije. Alati za 

izradu aplikacije: Eclipse, Gimp. Koristeni su isključivo alati otvorenog koda. Ideja je bila 

slušateljima radio prijenos TV radio UNIOS ETFOS programa pružiti mogučnost slušanja radio 

prijenosa dok nisu vezani za računalo i s time omogučiti prijenosnu mogučnost slušanja i samim 

time povečati broj slušatelja. 
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2. PAMETNI UREĐAJI 

Današnja tehnologija promijenila je stari mobilni uređaj, koji je služio za zvanje i slanje SMS 

poruka, svojim prvobitnim aplikacijama te se probila ideja „bilo kada, bilo gdje“ što je  

povečalo korištenje uređaja uvođenjem brojnih Internet aplikacija kao i sve većim zahtjevima 

korisnika te je tako nastao pametni telefon. Današnji pametni uređaji imaju sve jače 

performanse, što se čak može usporediti s računalom, kojeg pokreću jake dvije, četiri pa čak i 

više jezgri. 

 

2.1. APLIKACIJE ZA UREĐAJE 

Mobilne aplikacije s vremenom postaju zahtjevnije od prvobitnih aplikacija kao što su 

kalkulator, kalendar i slične. Uvođenje pristupa Internetu na mobilnim uređajima dovodi do 

brojnih aplikacija koje omogućuju Internet pretraživanje. Nedostatak su bile ne optimizirane 

Internet stranice koje su neprilagođenom rezolucijom spriječavale pa čak i odbijale korisnike 

od korištenja istih. Pojavom društvenih mreža i raznih Internet stranica, povečala se potražnja 

raznih aplikacija te se tako razvojem novih aplikacija korisnicima želi ponudit veći izbor i lakši 

pristup Internet pretraživanju kao i komunikaciju na društvenim mrežama. Većina kompanija 

za novosti i društvene mreže imaju svoje aplikacije za pametne telefone koje su bazirane na 

raznim operacijskim sustavima kao što su Android, IOS i druge. 

 

2.2. ANDROID OPERACIJSKI SUSTAV 

Android operacijski sustav stvoren je od tvrtke Google te je izrađen kao sustav otvorenog koda 

što znači da svatko može pristupiti kodu i po volji mijenjati te time ukloniti greške koje se mogu 

pojaviti. Samom činjenicom da je moguče mijenajti kod, programerima daje predonost 

kreiranja efikasnijih aplikacija i te veču ponudu za tržište. Operacijski sustav se sastoji od 

slojeva prikazanih na slici 2.2.1. Arhitektura Andorid operacijskog sustava. 
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Slika 2.2.1. Arhitektura Android operacijskog sustava 

 

Prvi sloj temeljen je na Linux jezgri inačici 2.6. koji služi za komunikaciju između hardvera i 

sofrvera. U sebi ima osnovne sustave koje služe za upravljanja procesa, upravljanja memorije, 

sigurnosti, mrežni stog i model upravitelja. Sloj Andorid RT (eng. „Android run time“) sadrži 

skup osnovnih biblioteka koje nude brojnije mogučnosti programiranja s Java programskim 

jezikom. Sastoji se od dvije važne komponente koje čine Davlik VM (eng. „Davlik Virtal 

Machine“) i glavne biblioteke (eng. „Core Libraries“) , knjižice koja sadrži večinu jezgrenih 

knjižica programskog jezika Java. Sloj Dalvik VM služi za prebavicanje Java datoteke u 

ekstenziju .dex koja je optimizirana za što manju potrošnju memorije u samom uređaju. Sloj 

biblioteke (eng. „Libraries“) sadržava C/C++ biblioteke koje koristi operacijski sustav. 
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Bibliotekama moguće je pristupiti preko aplikacijskog okvira (eng. „Application Framework“) 

koji je povezan na sustav. Sloj aplikacijskog okvira (eng. „Application Framework“) sastoji se 

od mehanizma za izradu aplikacija kreiranih za Android operacijski sustav. S time omogućeno 

je upravljanje programskim paketima, aktivnostima aplikacije, pozivima, prozorima, resursima, 

korištenje podataka od više različitih aplikacija, dohvačanje i korištenje trenutne lokacije 

korisnika, prikaz obavijesti te baza pogleda koji mogu biti korišteni za dizajn aplikacije. Na 

vrhu je sloj Android aplikacija koji dozvoljava korisnicima Andorid operacijskog sustava 

korištenje svih dostupnih aplikacija iz samoga uređaja. Korisnicima pružen je velik izbor svih 

aplikacija, kako besplatnih tako i plativih na stranicama Andorid trgovine koje se mogu pronaći 

na linku https://play.google.com/store za koji je potreban Google račun koji se poveže s vašim 

pametnim uređajem. 

https://play.google.com/store
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2. KORIŠTENI ALATI 

 

Korišteni su isključivo alati otvorenog koda (eng. „open source“. To omogućava korištenje svih 

alata bez potrebe licenciranja. 

 

3.1. ECLIPSE IDE 

 

Programiranje za Android operacijski sustav koristi se programski jezik JAVA. Programiranje 

u programskom jeziku Java zahtjeva alat kao što su Eclipse IDE, NetBeans i drugi. NetBeans 

koristi sučelje jednostavno za korištenje ali Eclipse IDE sadrži bolju podršku za programiranje 

aplikacija za Andorid operacijski sustav. Eclipse IDE u sebi sadrži sve potrebne dodatke kao 

što su na primjer Android SDK (eng. „Software Development Kit“) koji je potreban za kreiranje 

Andorid aplikacija. 

 

3.1.1. Instalacija Eclipse IDE na Windows operacijski sustav 

 

Pretraživanjem Interneta moguće je pronaći razne upute za instalaciju Eclipse IDE koji u sebi 

sadrži dodatak ADT (eng. „Android Development Tools“). Instalacija se vrši po jednostavnim 

uputama. 

 

3.1.2. Instalacija dodatka ADT (eng. „Android Development Tools“) 

 

Za instalaciju se koristi Update Manager u Eclipse IDE. Prvo je potrebno preuzeti dodatke, a 

postupak je opisan u slijedećim koracima: 

 Pokrenuti Eclipse IDE, a zatim odabrati Help > Install New Software... . 

 Kliknuti Add , u gornjem desnom kutu. 

 U dijaloškom okviru Add Repository, u polje Name upisati „ADT Plugin“, a u polje 

Location upisati poveznicu http://developer.android.com/tools/sdk/eclipse-adt.html 

 Kliknuti OK. 

 U dijaloškom okviru Avaliable Software, odabrati potvrdni okvir pored Developer 

Tools, a zatim kliknuti Next . 

 U sljedećem prozoru, pokazat će se popis alata za preuzimanje. Kliknuti Next . 

 Prikazat će se ugovor o licenci. Kliknuti Finish . 

http://developer.android.com/tools/sdk/eclipse-adt.html
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 Kada instalacija završi, ponovo pokrenuti Eclipse IDE. 

 

 

 

3.1.3. Konfiguracija ADT (eng. „Android Development Tools“) dodatka 

 

Nakon preuzimanja ADT-a, potrebna je modifikacija ADT postavki u Eclipse IDE slijedeći 

korake: 

 Odabrati Window > Preferences...   

 Odabrati Android s lijeve strane ploče. 

 Za SDK Location u glavnom panelu, kliknuti Browse... i odabrati skinutu SDK mapu. 

 Kliknite Apply , a zatim OK . 

  

3.1.4. Instalacija SDK (eng. „Software Development Toolkit“) 

 

Instalacija SDK platforme u Eclipse IDE sustav potrebna je za programiranje i prevođenje 

aplikacija. Instalacija se vrši u sljedećim koracima: 

 U Android SDK and AVD Manager odabrati Available Packages u lijevom panelu kao 

što je prikazano na slici. 3.1.4 

 Kliknuti na strelicu pored kvadratića, za prikaz dostupnih komponenata za instalaciju. 

 Odabrati barem jednu platformu za instalaciju i kliknuti Install Selected. 

 



7 

 

Slika 3.1.4. Andorid SDK i AVD manager 

 

3.2. STARANJE APLIKACIJE U ECLIPSE IDE SUČELJU 

 

3.2.1. Stvaranje AVD (eng. „Android Virtual Device“) 

 

Prije samog početka programiranja potrebo je stvoriti AVD u kojemu se konfigurira uređaj 

korišten u emulaciji. 

 

Za stvaranje AVD-a: 

 U Eclipse IDE odabrati Window > Android Virtual Device Manager. 

 Zatim, Andorid Virtual Devices u lijevom izborniku, kao što je prikazano na slici 

3.2.1.1. 
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Slika 3.2.1.1. Prikaz kreiranja novog AVD-a 

 

 Kliknuti New te se pojavi Create New AVD. 

 Upisati AVD-ovo ime kao npr. „testni_uredaj“. 

 Popuniti podatke postavki uređaja za koji se želi testirati, kao što je prikazano na slici 

3.2.1.2. 

 Kliknuti na OK za potvrdu postavki. 
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Slika 3.2.1.2. Postavljanje AVD konfiguracija 

 

Kao što se može vidjeti koristi se Android inačica 2.3.3.. Razloga toga je što kreirane aplikacije 

u toj verziji mogu koristiti preko 96% Android uređaja iako imaju noviju inačicu što u obratnom 

slučaju nije poželjno. Za provjeru je dodan Android uređaj s inačicom 4.4.2. 

 

3.2.2. Stvaranje novog projekta 

 

Za stvaranje novog projekta u Eclipse IDE se slijede jednostavne upute: 

 U Eclipse IDE odabrati  File > New > Project. 

Ako su ADT dodaci za Eclipse IDE uspješno instalirani dobiveni dijalog bi trebao imati 

označenu mapu Android koja sadrži Android Project kao što je prikazano na slici 

3.2.2.1.  

 Odabrati Android Application Project i kliknuti na Next.    
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Slika 3.2.2.1. Prikaz prozora s novim projektom 

 

 Ispunjavaju se detalji projekta sa vrijednostima, naprimjer kao što je  prikazano na slici 

3.2.2.2. gdje se odabire ime, najniža inačica te namijenjena inačica. Vrijednosti inačica 

su automatski podešene te ih je moguće mijenjati. 
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Slika 3.2.2.2. Prikaz novog projekata s popunjavanjem podataka za novu aplikaciju 

 

 Odabrati Next.    

 Zatim odabrati pojedinosti kao što su boja pozadine i kliknuti Finish 

 

Nakon što se projekt otvorio prikazan je u izborniku projekta (eng. „Project Explorer“) s lijeve 

strane prozora kao što je prikazano na slici 3.2.2.3. koji u sebi sadrži napisan program „Hello 

World“ što upućuje da program radi. 
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Slika 3.2.2.3. Prikaz otvorenog projekta 

 

Ako se otvori MainActivity.java datoteka koja se nalazi u ETFOSStreamingRadio> src> 

com.etfosstreamingradio kod izgleda ovako: 

 

package com.etfosstreamingradio; 

 

import android.os.Bundle; 

import android.app.Activity; 

import android.view.Menu; 

 

public class MainActivity extends Activity  

{ 

 

 @Override 

 protected void onCreate(Bundle savedInstanceState) { 

 

  super.onCreate(savedInstanceState); 

 

  setContentView(R.layout.activity_main); 

 } 

 

 @Override 

 public boolean onCreateOptionsMenu(Menu menu) { 

 

  getMenuInflater().inflate(R.menu.main, menu); 

 

  return true; 

 } 

 

} 

 

Uočljivo je da je kod temeljen na Activity klasi koja služi za izvršavanje radnji. Metoda 

onCreate ( ) poziva Android operacijski sustav kada njegova Activity započne. To je mjesto 

gdje se treba podesiti korisničko sučelje. Activity ne treaži korisničko sučelje ali ipak postoji 

potreba za njime. U aplikaciji za radio prijenos TV radio UNIOS Etfos activity pokreće radio 

stream sa streaming linka http://radio.unios.hr/ 

 

public class HomeActivity extends Activity implements OnClickListener { 

 

 private final static String RADIO_STATION_URL = "http://radio.etfos.hr:8000/radioetfos.mp3"; 

 

Svaka Android aplikacija mora sadržavati AndroidMainfest.xml datoteku koji prikazuje 

osnovne informacije o aplikaciji za Android sustav koje su potrebne za pokretanje aplikacije.  

http://radio.unios.hr/
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Ako se otvori AndroidMainfest.xml datoteka koja se nalazi u ETFOSStreamingRadio> kod 

izgleda ovako: 

 

<?xml version="1.0" encoding="utf-8"?> 

<manifest xmlns:android="http://schemas.android.com/apk/res/android" 

      package="com.trz.proba.streaming" 

      android:versionCode="1" 

      android:versionName="1.0"> 

    <uses-sdk android:minSdkVersion="3" /> 

    <uses-permission android:name="android.permission.INTERNET"></uses-permission> 

 

    <application android:icon="@drawable/icon" android:label="@string/app_name"> 

        <activity android:name="com.trz.proba.streaming.HomeActivity" 

                  android:label="@string/app_name"> 

            <intent-filter> 

                <action android:name="android.intent.action.MAIN" /> 

                <category android:name="android.intent.category.LAUNCHER" /> 

            </intent-filter> 

        </activity> 

 

    </application> 

</manifest> 

 

3.2.3. Dizajniranje korisničkog sučelja 

 

Ideja dizajna za aplikaciju temelji se na jednostavnom i brzom pristupu slušanja radio prijenosa 

TVradio UNIOS Etfos emisije. Aplikaciju možemo nazvati programskim korisničkim sučeljem 

što znači da je korisničko sučelje aplikacije konstruirano i izrađeno direktno u izvornom kodu.  

Za primjer može se uzeti tipku „Sviraj“ koja je konstruirana kodom: 

   

      <Button 

            android:id="@+id/buttonPlay" 

            android:layout_width="wrap_content" 

            android:layout_height="wrap_content" 

            android:layout_weight="1" 

            android:text="Sviraj" > 

        </Button> 

 

a grafički oblik možemo vidjeti na slici 3.2.3.1..  
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Slika 3.2.3.1. Grafički prikaz tipke Sviraj 

 

Prilikom pritiska na tipku „Sviraj“ pokreće se Activity klasa, koja je opisana u poglavlju 3.2.2.. 

Klasa koja pokreće radio prijenos TV radio UNIOS Etfos emisiju. Potvrdu o početku prijenosa 

dobivamo kratkom porukom „Sviram ;)“ koja se prikaže u koliko program započinje. 

 

private void startPlaying()  

{ 

 buttonStopPlay.setEnabled(true); 

 

 buttonPlay.setEnabled(false); 

 

 playSeekBar.setVisibility(View.VISIBLE); 

 

 player.prepareAsync(); 

 

 player.setOnPreparedListener(new OnPreparedListener() { 

 

  public void onPrepared(MediaPlayer mp) { 

 

   player.start(); 

 

   buttonRecord.setEnabled(true); 

 

   Toast.makeText(HomeActivity.this, "Sviram ;)", 5000).show(); 

  } 

 }); 

} 

 

Poruka „Sviram ;)“ ima drugu ulogu u samome programu. Služi za potvrdu valjanosti prijenosa 

programa TV radio UNIOS Etfos emisije. U koliko se ne pojavi poruka „Sviram ;)“ dogodila 

se greška u samom prijenosu zbog nedostatka Internet veze. Potrebno je provjeriti je li pametni 
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uređaj ispravno spojen na bežičnu mrežu ili na mobilni internet ukoliko se koristi. Poruku 

„Sviram ;)“ može se vidjeti na slici 3.2.3.2. 

 

 

 

Slika 3.2.3.2. Poruka „Sviram ;)“ ispisana prilikom pokretanja prijenosa 

 

Isto tako prilikom zaustavljanja prijenosa TV radio UNIOS Etfos programa, prilikom stiskanja 

tipke „Pauza“ izbaci se poruka da je zaustavljeno u obliku „Pauza“ prikazano kodom: 

 

private void stopPlaying()  

{ 

 if (player.isPlaying()) { 

  player.stop(); 

  player.release(); 

  initializeMediaPlayer(); 

 } 

 

 buttonPlay.setEnabled(true); 

 buttonStopPlay.setEnabled(false); 

 playSeekBar.setVisibility(View.INVISIBLE); 

 buttonRecord.setEnabled(false); 

 buttonStopRecord.setEnabled(false); 

 Toast.makeText(HomeActivity.this, "Pauza", 5000).show(); 

 stopRecording(); 

} 

Poruka je vidljiva na slici 3.2.3.3. 
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Slika 3.2.3.3. Poruka „Pauza“  za proces prekida prijenosa 

 

3.2.4. Izgled gotovog korisničkog sučelja i testiranje 

 

Prilikom pokretanja emulatora vidljiv je Android operacijskim sustavom čije su postavke 

prethodno podešene na Android inačicu 4.1 imenom Jelly Bean kao što je vidljivo na slici 

3.2.1.2. Slika 3.2.4.1. prikazuje emulator Android operacijskog sustava inačice 4.1.0. koji je 

podešen na najmanju podržanu inačicu 2.2.0. jer većina aplikacija napravljen za tu inačicu radi 

i za novije inačice, tako i aplikacija za radio prijenosa TV radio UNIOS Etfos. 

 



17 

 

 

Slika 2.3.4.1. Android operacijski sustav inačica 4.1.0 u emulatoru 

 

Prilikom pokretanja aplikacije, prikazano slikom 2.3.4.2., dobije se kratka poruka za 

dobrodošlicu u obliku „Dobrodošli“ koja upučuje na ispravanos pokretanja aplikacije. Prilikom 

testiranja aplikacije vidljivo je jednostavno sučelje s tipkama za pokretanje radio prijenosa, 

tipku za zaustavljanje radio prijenosa te kao dodatak dodana je opcija za snimanje i prekid 

snimanja prijenosa koju sprema u .mp3 formatu s putanjom na memorijsku karticu u uređaju. 
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Slika 2.3.4.2. Emulacija aplikacije TV radio UNIOS Etfos 

 

Tijekom radio prijenosa TV radio UNIOS Etfos programa, korisnici aplikacije mogu snimiti 

bilo koju pjesmu koja trenutno svira pomoću tipke „Snimaj“ , koja je vidljiva na slici 2.3.4.2., 

prikazana kodom: 

 

private void startRecording() { 

 

 BufferedOutputStream writer = null; 

 try { 

  URL url = new URL(RADIO_STATION_URL); 

  URLConnection connection = url.openConnection(); 

  final String FOLDER_PATH = Environment 

     .getExternalStorageDirectory().getAbsolutePath() 

    + File.separator + "snimke"; 

  File folder = new File(FOLDER_PATH); 

  if (!folder.exists()) { 

   folder.mkdir(); 

  } 

  writer = new BufferedOutputStream(new FileOutputStream(new File( 
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    FOLDER_PATH + File.separator + "snimka.mp3"))); 

  recordingStream = connection.getInputStream(); 

  final int BUFFER_SIZE = 100; 

  byte[] buffer = new byte[BUFFER_SIZE]; 

  while (recordingStream.read(buffer, 0, BUFFER_SIZE) != -1 

   && isRecording) { 

   writer.write(buffer, 0, BUFFER_SIZE); 

   writer.flush(); 

  } 

 

} 

 

Snimljeni podatci se spremaju na memorijsku karticu gdje ih je moguće bilo kada i bilo gdje 

ponovno poslušati kao i podijeliti s drugima. 

 

3.2.5. Testiranje na pametnom uređaju 

 

Aplikacija je testirana na uređaju Samsung Galaxy model  GT-6500D s inačicom 2.3.3.  

Na slici 3.2.5.1. je vidljiva aplikacija koja se nalazi u izborniku pametnog telefona. 
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Slika 3.2.5.1. Prikaz ikone aplikacije TV radio UNIOS Etfos u izborniku 

 

Na slici 3.2.5.2. prikazana je poruka dobrodošlice prilikom pokretanja aplikacije te 

jednostavan i brz preglednik aplikacije TV radio UNIOS Etfos. U izborniku tipka „Sviraj“ 

ima svjetliju boju. Time je označeno kako je samo nju moguće stisnuti da bi uspostavili 

prijenos TV radio UNIOS Etfos emisije te tako aktivirati i ostale tipke. 

 

 

 

Slika 3.2.5.2. Početni zaslon aplikacije 

 

Prilikom pritiska tipke „Sviraj“, prikazana na slici 3.2.5.3., vidljiva je poruka uspostavljenog 

prijenosa porukom „Sviram ;)“. Vidljiva je promjena boje tipki, te mogućnost primjene drugih 

tipki, kao što su opcije „Pauza“ koja zaustavlja prijenos i opcija „Snimaj“ kojom je moguće 

snimiti emisiju. 
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Slika 3.2.5.3. Prikazuje početak prijenosa prijenosa TV radio UNIOS Etfos emisije 

 

Na slici 3.2.5.4. prikazan je početak snimanja trenutne radio emisije. Može se uočiti da je 

omogučena opcija za zaustavljanje snimanja označena tipkom „Zaustavi“ koja automatski 

sprema snimak na lokaciju memorijske kartice. Putanja datoteke prikazana je i na samoj 

aplikaciji. 
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Slika 3.2.5.4. Prikazuje prijenos dok je omogućeno snimanje 

 

Zaustavljanjem, tipkom „Pauza“, prekidamo radio prijenos TV radio UNIOS Etfos emisije. U 

koliko snimanje emisije nije bilo zaustavljeno, prekidom s tipkom „Zaustavi“, automatski će 

snimiti do trenutka stiskanja prekida, tipke „Pauza“. Kada stisnemo tipku „Pauza“ na ekranu 

se ispiše poruka kojom je potvrđeno zaustavljanje u obliku „Pauza“ vidljivo na slici 3.2.5.5. 
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Slika 3.2.5.5. Prikaz poruke „Pauza“ prilikom zaustavljanja prijenosa 
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4. ZAKLJUČAK 

 

Android operacijski sustav pogodan je za korištenje svih vrsta aplikacija, tako i aplikaciju radio 

prijenosa TV radio UNIOS Etfos. Aplikacija je jednostavna za korištenje te bi trebala povećati 

broj slušatelja programa. Sljedeći plan za aplikaciju TV radio UNIOS Etfos je dodavanje 

mogućnosti pregledanja emisija i hita tjedna te postavljanje aplikacije na Google trgovini tako 

da je dostupna svim korisnicima koji imaju želju slušati radio prijenos TV radio UNIOS Etfos 

emisije. 
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SAŽETAK 

 

Android operacijski sustav se svakim danom unaprjeđuje radi poboljšanja kvalitete usluge 

korisnicima kako za pametne uređaje tako za tablete, računala i televizore koji koriste Android 

operacijski sustav. Aplikacije za Android operacijske sustave izlaze svakodnevno za razne 

prigode kao aplikacije ili igre. Aplikacije nastaju u par jednostavnih koraka: postavljanje 

Android AVD-a (Virtual Device), kreiranje novog projekta, planiranje aplikacije, izrada 

aplikacije i kreiranje .apk ekstenzije koja služi za instaliranje aplikacije na sve uređaje s 

Android operacijskim sustavom. Aplikacija TV radio UNIOS Etfos korisnicima aplikacije 

pruža mogućnost slušanja radio prijenosa programa TV radio UNIOS Etfos-a na bilo kojem 

mjestu gdje imaju pristup Internetu. 
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ABSTRAKT 

 

Android operating system is daily improved in order to improve the quality of customer service 

for smart devices like tablets and smartphones as like as computers that use the Android 

operating system. New applications for Android operating system are published daily for a 

variety of occasions like applications or games. Applications are created in a few simple steps: 

setting of the AVD (Android Virtual Device), creating a new project, planning the application, 

designing the application, and creating the .apk extension which is used to install the application 

on all devices with Android operating system. The TV radio UNIOS Etfos application provides 

users the option of listening radio stream of TV radio UNIOS Etfos at any location where one 

can have Internet access.  
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